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1) Introduction

The SavFIRe digital filter processor can easily be configured to apply multiple filters to a single digital input
data stream. This application note describes the methodology for designing the desired filters (using the
QF1Da512-DK development kit), creating the configuration data for download to the device, and defining the

control

of the input data stream to obtain the desired results.

This same technique can be used in both the QF1D512 and also the QF1Da512.

2) Summary

Step 1:

Step 2:

Step 3:

Setup the configuration of the SavFIRe as if you were using just one filter.

For a dual-filter implementation, it is preferable to use symmetric filters (which is what our tool builds
anyway). The use of symmetric filters is only possible in this dual-filter application if one of the filters
is an odd length symmetric filter (i.e. there will be a center tap) and the other is implemented as an even
length symmetric filter.

For implementations using more than two filters, use asymmetric filters. Asymmetric filters will allow
for only half as many taps as are available with symmetric filters.

For sample rate, use the rate your data would come in for each channel. Don’t multiply up. For
example, if you have four filters designed for a 1 KHz sample rate, build the filters with a 1 KHz sample
rate, not 4 KHz.

Refer to Table 1 for examples of allowable filter lengths.

Save the coefficients to separate text files. You will be opening them in an Excel spreadsheet.

Interleave the coefficients of the various filters, alternating between them. The first coefficient for the
first filter is placed in location 0, the first coefficient for the second filter is placed in location 1, ..., the
first coefficient for Mth filter is placed in location M-1, the second coefficient for the first filter is placed
in location M, etc.

Save these as a text file and use the import function of our tool to bring them back in. Ignore the
representation of the new “filter” you see on the screen. The software is assuming only one filter is
present, but this is not the case in your application.
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Step 4:

Data sent to the chip must have zeros interleaved into the data stream. Thus you would send a data
sample one on the first clock, a zero on subsequent clocks (for the next M — 1 clocks), then a data
sample on the next clock followed by M — 1 zeros, and so forth.

3) Concept

As an example consider Figure 1 where a QF1Da512 device is configured to simultaneously process an input
data stream with three separate filters. At time n, where n is the input sample number, sample x(n) is in the
“newest” location in the input sample buffer, and sample x(n-k) is the “oldest” location. The current output,
y(n), corresponds to filter 1, which is defined by the coefficients h;(k). When the next input arrives, which in
this example is an inserted zero, the data values shift in the buffer and the calculated output, y(n+1),
corresponds to filter 2, which is defined by the coefficients hy(k). A similar shifting of the input buffer and
calculation yields y(n+2) corresponding to filter 3, which is defined by the coefficients hz(k). Then the cycle
repeats, beginning with a new input data sample and computing the next output corresponding to filter 1.

Note that the coefficient space is m times the number of taps of the longest filter. For smaller filters,
coefficients with zero value are inserted at the end of the coefficient vector to equal the number of taps of the

longer filter.

Three Filter Example

Input
Samples

x(n+1), 0,0 —+ x(n)

Multiply/Accumulate

h1(0)

Data

0 0 x(n-1) 0 0 x(n-2) 000 x(n-k)

Output
Samples

yi(n), y3(n-1), y2(n-1), y1(n-1) —

h2(0)

h3(0)

h1(1)

h2(1)

h3(1)

000

h1(N-1)

h2(N-1)

h3(N-1)

Coefficients

De-interleave

y1(n-2) y2(n-2) y3(n-2)

y1(n-3) y2(n-3) y3(n-3)

y1(n-4) y2(n-4) y3(n-4)

0 0 0
0 0 0
0 0 0

Figure 1. Three-filter example flow chart
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4) Design Considerations

The SavFIRe can be programmed to execute multiple filters on the same input sample stream if the following
conditions are met:

1)

2)

3)

4)

5)

6)

7)

8)

When using asymmetric filters, the total coefficient space of 256 coefficients must not be exceeded.
Thus, m times the number of coefficients of the longest filter must be < 256, where m is the number of
filters. This value is input as the number of taps (NUM_TAPS) in register address 06h, bits 0-7.
Register address 07h must be zero.

Symmetric and asymmetric filters cannot be mixed. Either one or the other must be used exclusively.

When using symmetric filters, the total coefficient space of 512 coefficients is not to be exceeded. In
this case, the maximum number of filters is two. One filter must use an odd number of taps (maximum
of 255) while the other filter uses an even number of taps (maximum of 254). The total number of taps
used is input (NUM_TAPS) in register address 06h, bits 0-7, and Register address 07h, bit 0. Note: the
even tap filter will have a null at Fs/2.

For asymmetric filters, the shorter filter(s) must be appended with zero value coefficients to have the
same number of taps (coefficients) as the longest filter.

The coefficients, h; (k), where f is the filter identifier (0, /, 2 ...m-1), and k is the coefficient number (0,
1, 2 ...N-1), are placed in coefficient memory at address (m x n + f)h. Thus the filter coefficients
for filter O are placed in addresses 0, m, 2m, etc.; coefficients for filter 1 are at 1, m+1, 2m+1, etc.

The effective input sample rate (m times the original data sample rate) cannot exceed the maximum
input sample rate of the device.

For each sample out of the ADC, the system must insert m-1 zero-valued samples. This is readily
implemented with the SavFIRe operating in the co-processor configuration where the system’s micro-
controller inputs samples to the SavFIRe device. The micro-controller must also sort the output sample
stream into the appropriate filter sample space, as it will receive alternating samples for each filter.

The following table illustrates the maximum number of taps per filter, the maximum sample rate per
filter, and the latency of each filter for multiple filter configurations.
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Number of Max Taps Max Sample

Filters (per filter) Rate
Per Filter

1 symmetric 512 500 KHz
1 asymmetric | 256 500 KHz
2 symmetric 255 250 KHz
2 asymmetric 128 250 KHz
4 asymmetric | 64 125 KHz

m asymmetric | 256/ m 500 KHz /' m

Table 1. Number of filters, maximum number of taps and maximum sample rate.

5) Implementation

The QFPro QF1Da512 software can aid the development of the SavFIRe configuration file for executing
multiple filters. However, the development board cannot be used to display the FFT results of the multiple
filters, since the on-board controller is not programmed to support the insertion of zeros into the input stream, or
to sort the output stream into the individual filter samples. The following steps are used to create the
configuration file:

1. Design the filters using the QFPro filter editor (or other filter design tool of your choice), and save the
coefficients for each filter. Save the coefficients by selecting Filter Data under the Window menu and
then pressing the Save to File button at the bottom of the coefficient display (as shown in Figure 2).
Select the file location, name the file, and press Save.

2. Interleave the coefficients into a single file per rule 4 above as shown in Figure 3. If some filters have
fewer taps than others, append coefficients of zero value to make all filters have a number of coefficients
equal to the number of coefficients of the filter with the most taps. The total coefficient space of the
newly created coefficient file will be equal to the number of filters times the number of taps in the
maximum tap filter. The completed file format must be a single column of floating point coefficients.

3. Import the new coefficients into the QFPro filter editor using the asymmetric or symmetric filter import
capability as appropriate (as shown in Figure 4). The appropriate screen (Create Filter) is reached by
selecting New Filter under the File menu. Select the ASYM (or SYM) icon on the Imported Filters line,
and then select the file to import from the file selection dialog.

4. Press the Design Filter button, and when complete, press the Done button to enter the configuration
dialog page.

5. Select the Coprocessor configuration in the Data Input Source field, and set up the chip per your
application using the Data Format Editor and the Pins Settings Editor under the Chip menu.
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6. Press Start to download the configuration to the QF1Da512 on the development kit. You may then use
the Read/Write screen on the Chip menu to display and verify the chip settings.

7. Save the configuration using the Save Configuration selection in the File menu, and export the
download image via the Export Image selection in the File menu. The Export Image dialog will permit
the file to be saved as a text file, an Intel Hex file, or as C code files (as shown in Figure 5).

8. Develop the code for capturing the ADC samples and transferring these samples to the QF1Da512 co-
processor, and capturing the filtered samples. Insert m-1 zero valued samples, where m is the total
number of filters, between each ADC sample input to the device. You may feed samples to the device at
a maximum rate of 500ksps. You may also select to sort the samples from the QF1Da512 into m
separate files as they are collected for independent filter analysis.
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F1D512 Filter Editor,
File Edi Wew Mindow Help

=21
[ FIR Specification Editor || B Filter Data - 32 Bits Quantized Mode (=]
Parks-McClellan: Lowpass Coaelfcizrts | Fer Response | pec Values |
~speciication: Index [ Resut | Caefficient ]

1 FFa16705 -0.00386:3451537

Chip Type: QF1DS12 2 FD&1FDFD -0.018493832159
3 FE3DIEFS -0.037193421274

Sampling Frequency: 1 kHz > DK 2 4 FBAGGESD -0.033963431756
s (r30C3804 0.023810843006

Passband Upper Frequency: | 0.1 ke & 1183946 0136828261428
7 20902915 0.254796157125

Stophand Lower Frequency:  [0.25 kHz g 271B2E47 0.305516931299
P auena ] 20902915 0.254796157125

10 11639646 0.136626261428

Passhand Ripple: 1 B 8 081 B m 300304 0023910843006,
12 FEAGEESD -0.033983431756

Stophand Attenustion: 0 a8 & | e0907 dg 13 FE3D3EFS _0.037193421274

14 FDAIFDFD -0.018493592158

Number of Taps: 15 3: ¥ Minimize Taps Estimate: 15 FF&16705 -0.003863451537
<tnde edes

Sampling Frequency

The sampling frequency for this fiker

Li

its
1.000 Hz <= Sampling Frequency <= 500.000 kHz

{ all values are approsimate )

Save to File Copy to Clpboard

Ready | Conwerges: & ‘es | MestsSpec: & Pass | Chip Type: QFLDS1Z

Figure 2. Export coefficients for each filter via the "*Save to File" button
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B Hfilters.txt - Notepad Z E rz|
File Edt Farmat View Help

-0, 011826018803
-0, 004305183422
-0, 007962567266
-0, 018493892139
-0, 0217656858434
-0. 032174884807
-0.037193421274
-0, 030021471515
-0, 029069411103
-0, 033983431736
-0. 006497010589
084036254011
023810843006
113721924368
2832762043508
136828261428
. 345873778082
. 388460010250
. 234796157125
. 271410603074
283276294358
.305516091290
J113721924368
084036254011
. 254796157125
. 006497010589
029060411103
0.136828261428
039021471515
032174884807
. 023810843006
021765688434
007962367266
033083431754
004305183422
. 000000000000
0371093421274
. 000000000000
. 000000000000
. 018493892159
. 000000000000
. 000000000000
. 003863451537
. 000000000000
. 000000000000

I 1
KT T KT KT L Ex KT KT Ex K KT E E O L L

1 1 I 1 1 1 1
ET o KT KT Lo Ex T KT o (0 LT

1 1
Eor KT o O KT

Figure 3. Interleaved coefficients from three filters
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E1 QF1D512 Filter Editor

File Edt Wiew Window Help

G| » m oo |l

Bl FIR Specification Editor

(2 ]2

Imported Asymmetrical Caefficients Filter

Coeficients | Fiter Fesponse | Spec Values |

. Index | Result | Cosfficient
pecific
1 FE7C7C2A -0,011826018603
Chip Type: QF1Ds12 2 FF7ZEDEL -0.004305183422
3 FEFBLS25 -0,007962567266
Sampling Frequency: 1 kHz > DK 2 4 FDALFDFD -0.018493892159
5 FD36CEC -0,021765688434
Nurnber of taps: 45 [ FEE1B181 -0,0321 74884807
" 7 FE3DIEFS -0,037193421274
Coekficient File: [ Cipocuments and Settings\dernis bestiy C & FB01sE2C -0.039021471515
] FC477418 -0,029063411103
s 4 | L —rT
0 -0.011826018803 12 0AC25AFT 008405625401 1
1 -0.004305163422 ) 13 03003804 0023510843006
2 D.007962567266 14 OESETOAS 0113721524368
3 -D.018493892159 15 24426508 0263276204358
4 D.021765668434 16 11839645 0.136626261428
5 -0.052174884807 17 2C45DEEY 0,345973776962
6 0.037193421274 18 31BA0ECD 0.36346001 0290
7 0.039021471515 19 20902915 0254796157125
3 -0.029069411103 20 22809528 0271410603076
9 0.033% 21 244265CA 0283276294358
- S - 22 27162E47 0,305516991299
z3 OEBE70AS 0.113721924368
<-lndo || Design Fiker | Redo-> 4 Done 24 OAC2SAFT 0.054056254011
2 20902915 0254796157125
Sampling Frequency 26 FF261620 -0,006497010589
27 FC47741B -0,029060411103
The sampling requency for this fiker 78 11839646 D. 136826261428
o 29 FED1562C -0,039021471515
L a0 FEE1B181 -0,0321 74884607
1.000 Hz <= Sampling Frequency <= 500,000 kHz 5t 0303804 0023510843008
(1ot e srEmrae 32 FD36CE2C -0,021765686434
33 FEFBL525 -0,007962567266
34 FEABEESD -0.033983431 756
35 FF72EDE1 -0,004305183422
36 00000000 0,000000000000
37 FEIDIEFS -0,037193421274
38 00000000 0.,000000000000
» 00000000 0,000000000000
40 FDAIFDFD -0,015493852159
41 00000000 0.,000000000000
42 00000000 0000000000000
43 FF816705 -0,003063451537
44 00000000 0000000000000
45 00000000 0000000000000
SavetaFile Copy to Clipbaard

| Mests Spec: & Pass | Chip Type: QFIDS12

Figure 4. Asymmetric filter import of interleaved coefficient file
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Export Configuration E|

Configuration: | Ci\Documents and Settingsidennis bestiMy Documents\EngineeringiFilkersi,3 Filker co

Export Locakion

(" Store exported File(s) in same directory as configuration

{* Store exported file(s) in the directary specified belaw:

| C\Documents and Settingstdennis bestiMy DocumentsiEngineering) Filkers

Expart Types
s i Filename anly

W Tk File (. bxt) | 3 filter config Wiew, .,

v Ccode (e, Jh) | 3 filker config View, .,

LA

v Hex (hex) | 3 Filer config Wigw, ..

Skatus:

Generating . TXT File For 3 filker config ... Y
Created CHDocuments and Settingsidennis besti My Documents\EngineeringiFilkerst 3 filker config,
Generating . & .H files for 3 filker config ...

Created CrDocuments and Settingsidennis besti My Documents\EngineeringFilkers) 3 filker config,
Created Cri\Documents and Settingsidennis bestiMy Documents\EngineeringFilkers\3 filker config, »

o |

Figure 5. Export configuration as text, C code, or Intel hex file
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I 3 filter, config. hex - Notepad
File Edt Format View Help

$200000000080000023002C0000000000000018000305010101010101042EER030000000009E
P20002000FETCYC2ZAFF72EDSLFEFELS2 5FDALFDFDFD3GCE2CFBELIELB1FE3D3EFSFBO1I82CD3
$20004000FC47741EBFBAGSESOFF2E1B200AC25AF7030C3BD4 0EBE70AS244265CA118396A5E
1 200060002C48DEGDE1IBO0ECO200D2 0152 2BD05 28244 265CAZ71EZE4 7OEBEYOASQAC SAFTSC
(2000800020902 91 5FFZB1EZOFC4 7741E118396A6FE0] 582CFBELIBLA1030C3ED4FD3GCE2CEE
1 2000A000FEFELS2 5FBAGGESOFF7ZEDBLO0000000FE3ZD3EFS0000000000000000FDALIFDFDCD
1 2000C0000000000000000000FF8L6705000000000000000000000000000000000000000034
P2000E000000000000000000000000000000000000000000000000000000000000000000000
1 200100000000000000000000000000000000000000000000000000000000000000000000DF
$200120000000000000000000000000000000000000000000000000000000000000000000EF
$2001400000000000000000000000000000000000000000000000000000000000000000009F
1 2001600000000000000000000000000000000000000000000000000000000000000000007F
$2001800000000000000000000000000000000000000000000000000000000000000000005F
$2001A00000000000000000000000000000000000000000000000000000000000000000003F
1 2001C00000000000000000000000000000000000000000000000000000000000000000001F
$2001EQO00000000000000000000000000000000000000000000000000000000000000000FF
1 200200000000000000000000000000000000000000000000000000000000000000000000DE
$200220000000000000000000000000000000000000000000000000000000000000000000EE
$2002400000000000000000000000000000000000000000000000000000000000000000009E
1 2002600000000000000000000000000000000000000000000000000000000000000000007E
$2002800000000000000000000000000000000000000000000000000000000000000000005E
$2002A00000000000000000000000000000000000000000000000000000000000000000003E
12002C00000000000000000000000000000000000000000000000000000000000000000001E
$2002E0000000000000000000000000000000000000000000000000000000000000000000FE
1 200200000000000000000000000000000000000000000000000000000000000000000000DD
$200320000000000000000000000000000000000000000000000000000000000000000000ED
$2003400000000000000000000000000000000000000000000000000000000000000000009D
1 2003600000000000000000000000000000000000000000000000000000000000000000007D
$2003800000000000000000000000000000000000000000000000000000000000000000005D
$2003A00000000000000000000000000000000000000000000000000000000000000000003D
12003C00000000000000000000000000000000000000000000000000000000000000000001D
$2003E0000000000000000000000000000000000000000000000000000000000000000000FD
12004 00000000000000000000000000000000000000000000000000000000000000000000DC
CO0000001FF

Figure 6. Intel hex file for three-filter configuration
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Contact Information:

Quickfilter Technologies, Inc.
1024 S. Greenville Avenue, Suite 100
Allen, TX 75002-3324

Phone:214-547-0460
Fax:214-547-0481

The contents of this document are provided in connection with Quickfilter Technologies, Inc. products. Quickfilter makes no representations or warranties with respect to the
accuracy or completeness of the contents of this publication and reserves the right to make changes to specifications and product descriptions at any time without notice. No
license, whether express, implied, arising by estoppel or otherwise, to any intellectual property rights is granted by this publication. Except as set forth in Quickfilter's Standard
Terms and Conditions of Sale, Quickfilter assumes no liability whatsoever, and disclaims any express or implied warranty, relating to its products including, but not limited to,
the implied warranty of merchantability, fithess for a particular purpose, or infringement of any intellectual property right.

Quickfilter's products are not designed, intended, authorized or warranted for use as components in systems intended for surgical implant into the body, or in other
applications intended to support or sustain life, or in any other application in which the failure of Quickfilter's product could create a situation where personal injury, death, or
severe property or environmental damage may occur. Quickfilter reserves the right to discontinue or make changes to its products at any time without notice.

© 2007 Quickfilter Technologies, Inc.
All rights reserved.

Quickfilter, the Quickfilter logo and combinations thereof, are trademarks of Quickfilter Technologies, Inc.
Other product names used in this publication are for identification purposes only and may be trademarks of their respective companies.
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